Outlook 2010 Sharing and Using Calendars

Frequently Asked Questions:

How do I share my calendar? .......................................................... 1
How can I organise my list of calendars? ................................. 6
How do I make past appointments private? ............................. 8
How do I make a future appointment private? ....................... 16
What’s the difference between appointments and meetings? 13
How do I schedule a series of monthly appointments? .......... 17
How do I invite colleagues to a meeting? ............................... 20
How can I tell when colleagues are available to meet? .......... 21
How do I change a meeting time or location? ......................... 26
Can I turn an email into an appointment or task? ............... 28, 32
How can I set an expiry date for meeting invitations? ......... 33
## Contents

1. Sharing and Using Shared Calendars ................................................................. 1
   - Sharing your calendar ....................................................................................... 1
   - Responding to Requests to Share ..................................................................... 3
   - Changing the Permissions on a Shared Calendar ............................................ 3
   - Adding Colleagues’ Calendars to Your List....................................................... 4
   - Viewing Colleagues’ Calendars ...................................................................... 4
   - Overlaying Calendars ...................................................................................... 5
   - Creating and Using Calendar Groups ............................................................ 6
   - Deleting a Group ............................................................................................. 7

2. Archiving Your Calendar for Privacy and to Optimise Storage .......................... 8
   - Auto Archive Global Settings ......................................................................... 8
   - Manually Adjusting Auto Archive Settings for Individual Folders .................. 10
   - Manually Archive your Calendar .................................................................. 12

3. Appointments (for you alone) ........................................................................... 13
   - Appointments vs Meetings ............................................................................ 13
   - Creating an Appointment ............................................................................... 13
   - Using the ‘New Appointment’ Button ............................................................ 13
   - Creating a New Appointment Directly From the Calendar ............................ 14
   - Changing or Deleting Existing Appointments ............................................... 15
   - Amending or Deleting Appointments from the Dialogue Box ....................... 15
   - Amending or Deleting Appointments Directly from the Calendar ................. 15
   - Keeping Appointments Private ..................................................................... 16
   - Setting Appointments as Recurring ............................................................. 17
   - Changing Recurring Appointments ............................................................... 18
   - Creating Appointments for Others ................................................................. 19

4. Meetings (for you and others) .......................................................................... 20
   - Creating a Meeting ......................................................................................... 20
   - Using Scheduling Assistant to Determine the Best Meeting Time .................. 21
   - Adding Attachments to Meeting Invitations ................................................. 22
   - Booking Resources ......................................................................................... 22
   - Responding To Meeting Invitations ............................................................... 23
   - Tracking Meeting Request Responses ......................................................... 25
Changing Meeting Invitations ........................................................................................................... 26
Adding and Removing Attendees ...................................................................................................... 26
 Cancelling a Meeting ....................................................................................................................... 27

5. Combining Email, Calendar and Tasks plus Other Email Tips ..................................................... 28
 Converting Emails to Appointments Including Attachments .......................................................... 28
 Creating Tasks from Email Messages ............................................................................................... 32
 Setting an expiry date for a meeting invitation ................................................................................ 33
 Using ‘Conversations’ To Change the Display of Messages ............................................................. 34

6. Helpful Internet Links .................................................................................................................... 35
 General Outlook Help ....................................................................................................................... 35
 Help with Synchronisation ............................................................................................................... 35
 LSE’s own Help pages ...................................................................................................................... 35
 Android to Exchange: ..................................................................................................................... 35
 iCal to Exchange: ............................................................................................................................ 35
 iPhone/iPad to Exchange: ................................................................................................................. 35
 Entourage to Exchange .................................................................................................................... 35
1. Sharing and Using Shared Calendars

Microsoft Outlook 2010 provides additional useful features when it is run on computers connected to networks like LSE’s, which run Microsoft Exchange Server software. These features include to sharing calendars and collaborating with other people on the network. These features will not be available for use on your home computer or laptop unless you log in to the LSE network using Remote Access or VPN.

In this section we will look at one of these features; namely the sharing of calendars. You control who can view your calendar as well as what level of access those you share with can have. Similarly, if a colleague has set up permission for you to do so, you can view, add, update or delete appointments and meetings in her calendar on her behalf.

Sharing your calendar

For privacy, it is the ‘owner’ of a calendar who allows other people to access it. Outlook allows you to individually select the people who are allowed access to your calendar. (NOTE: you can share only with other people on the same network; you cannot share with your partner, for example, unless they also have access to the LSE network.)

1. Select the Home tab and find the Share group of buttons. Click on Share Calendar.

2. This will open a Sharing Request which is a kind of email message that you can send to all the people you want to share your calendar with.

3. In the To... field enter the email address of the person you would like to allow to see your calendar.
4. Select the **Request permission to view recipient’s calendar** option if you would like to be able to see other person’s calendar as well. You will need to wait for the other person to give you permission before you will be able to do this.

5. Click **Send** and the request will be sent to the other person after a message from Outlook asking you to confirm that you really want to do this.

Notice that by default the other person has only got permission to **read** your calendar and not make any alterations to it. We will look at how to change these permissions later.

6. If your request to view their calendar is approved, you will receive an **Allowed: Sharing request** message from the other person confirming that you are now able to access their calendar.

7. To add this calendar to your viewing list, click on the **Open This Calendar** option.

8. This will open the other person’s calendar alongside yours and display a check box for the calendar in your navigation pane.

9. Click the check box to display the calendar; click it again to clear the calendar from your screen.
Responding to Requests to Share

You may be asked by a colleague to share your calendar. This will come in the form of a Sharing Request like the one detailed above.

1. A Sharing Request will appear in your normal email inbox. Double click to open the request.
2. Click Allow or Deny as appropriate.
3. If the sharing request came due to another user sharing their calendar with you, then you will be prompted to open their calendar to put a checkbox for their calendar in your own navigation pane.

Changing the Permissions on a Shared Calendar

As the ‘owner’ of your calendar, you are able to dictate what other people can see or do with your calendar. By default Outlook allows Read Only rights to those with whom you have shared your calendar. To allow greater access to your calendar you need to adjust these permissions on an individual basis.

1. From the Home tab click on the Calendar Permissions button in the Share group on.

This will open the Calendar Properties dialogue box.

2. Select the Permissions tab and scroll to find the user that you wish amend. Click to select the user.
3. Click on the Permission Level drop-down list to choose a pre-set collection of permissions, or custom-build permissions using the options beneath.
4. Click **OK** to finalise this process.

Adding Colleagues’ Calendars to Your List

Once a colleague has given you permission to view his calendar, you can add it to your list at any time:

1. Right click on the Calendar group in which the new calendar is to be listed and select **Add Calendar | From Address Book**. (In this example, we right-clicked on **My Calendars**.)
   
   The **Select Name: Global Address List** dialog box opens.

2. Search for the people whose calendars you want to list and double-click each to add them to the list at the bottom of the window.

3. Click **OK** to close the dialog box. The new additions will be listed. **NOTE:** if you have not been granted permission to view a calendar, it will be shown only with times blocked out as ‘Busy’.

Viewing Colleagues’ Calendars

Outlook allows some choice in how you view your colleague’s calendars. The ‘traditional’ view is to have the two (or more) calendars displayed side-by-side.
You can also change the Outlook view from Day, as it is here, to Work Week, Week, Month, etc. and both calendars will adopt the new view together.

**Overlaying Calendars**

A more sophisticated way of viewing the calendars is to overlay them on top of each other.

1. On the View tab click on the Overlay button in the Arrangement group. Or click on the arrow next to the calendar name.

Both calendars will occupy the same area on the screen.

2. Select individual calendars by clicking on the colour-coded tabs at the top
Creating and Using Calendar Groups

Managing a large number of colleague’s calendars can cause difficulties. There may be times, for example, when you will need to quickly access:

- The calendars of all your team members
- The calendars of your fellow managers
- The calendars of the team members and managers who are working on a particular project.

Group the individuals concerned into Calendar Groups and then select a specific calendar group to quickly view the calendars of all the members of that group. NOTE: an individual’s calendar can be in more than one group.

1. Select the Home tab and click on the Calendar Groups button in the Manage Calendars group and create a group by selecting Create New Calendar Group.

2. You will be prompted to name the group. Type in the name of the group and click OK.

3. Select the members of your group from the Address Book.

4. Select members as required and click on the Group Members button to put them into the group.
5. The group will appear in your navigation pane, from where you can select or deselect the whole group. You can also select/deselect individual members. This does not remove them from the group, but does allow you to choose which calendars you would like to see. Notice also that the display of the group’s calendars looks very different here. This is using Schedule View, which is probably the best view to display a large number of calendars simultaneously.

Notice also that the bottom few group members have another icon next to their names. These calendars, although they are in your group, have not been shared with you. This icon is a short cut into sending a sharing request to these group members.

Deleting a Group

To delete a group, right click on the group name in the navigation bar and select Delete Group
2. Archiving Your Calendar for Privacy and to Optimise Storage

After a while your calendar will fill up with many appointments and meetings. In time this can lead to problems caused by the sheer volume of items in your calendar, slowing down Outlook and using up valuable space in your email quota. You can keep your Outlook calendar up to speed and clear by archiving old appointments.

Additionally, this is an excellent way to keep your past appointments private as archived events will be removed from your shared calendar and stored in an archive calendar in your private H: space. (You can elect to store it elsewhere, but H: is the recommended location as it is backed-up regularly and is private.)

There are three archiving options in Outlook:

- You can set global Auto-Archive settings, which will make Outlook automatically archive predetermined items on a regular basis. These settings will apply to all Outlook folders (Email, Calendar, Tasks etc). You set the criteria that apply for this.
- You can amend Outlook's global settings for specific folders and have them archive automatically according to different criteria to the global settings.
- You can manually archive a folder at the time of your choosing.

Auto Archive Global Settings

1. Select the File tab and then click on Options.
2. Select **Advanced** and click on **Auto Archive Settings**.

3. This will open the **Auto Archive** dialogue box (see overleaf).

4. Check the **Run AutoArchive every** box to switch AutoArchive on and select how often you want to run the auto-archive process. Uncheck this box to switch auto-archive off.

5. Select the **Prompt before AutoArchive runs** option if you want to be told whenever AutoArchive is about to take place.

6. Select the options you require in the **During AutoArchive** area including whether you wish to archive or delete old items and/or expired items and whether you want to have the archive folder displayed in your folder list.

7. In the **Default folder settings for archiving** area you can set the age of items you wish to clear, where you want to move them to and whether you want to permanently delete old items rather than just archive them.
8. Click **Apply these settings to all folders now** when you are happy with your selections and click **OK** to finish.

Remember that this process will archive all items in Outlook, not just the Calendar items.

**Manually Adjusting Auto Archive Settings for Individual Folders**

You can change the archive settings for specific folders rather than adopting the global settings described above. You could, for example, choose to have different settings for the calendar folder.

1. Find the folder you wish to archive in the **Navigation Pane** on the left of your screen.
2. Right click on it and select **Properties**
This will open the **Calendar Properties** dialogue box.

3. Select the top button to choose not to archive items at all in this folder.

4. Select the second button to apply the global default AutoArchive settings to the folder. Click on the **Default Archive Settings** button to access these settings and adjust if necessary.

5. Select the third button to apply custom AutoArchive settings to the folder and make selections in the area beneath in the same way as described for the global settings above.
Manually Archive your Calendar

Outlook will also allow you to manually archive your calendar as well as archiving automatically.

1. Click on the File tab, select Info.
2. Click Cleanup Tools and select Archiving.

This will open the Archive Dialogue Box.

3. Select the top button to manually archive all folders according to their default AutoArchive settings. Do this to do an ‘extra’ archive over the automatically scheduled archiving.

4. Select the second button to manually archive a specific folder.

5. Select the folder to be archived and select the archive settings you require including where you would like the folder to be archived and click OK to proceed.

Manually archive all folders at default settings
Select to specify a folder to archive
Select folder to be archived
Adjust archive settings
3. Appointments (for you alone)

Appointments and meetings are the most frequently used features of Outlook calendars.

Appointments vs Meetings

Outlook uses the term **Appointment** to refer to calendar entries that relate just to the owner of the calendar. Appointments are for you alone. They can be created, amended, deleted or archived to remind you of what you need to do in the future and/or used as a record of what you did in the past.

**Meetings** are appointments to which other people have been invited and which will feature in their calendars as well. They are events arranged between you and others.

The two things are similar, but meetings have a range of specific features and are dealt with separately in this manual. In this section, we will look at Appointments.

Creating an Appointment

There are two ways in which you can create an appointment in your calendar: using the **Add New Appointment** button and dialogue box, or by clicking directly onto the calendar.

Using the ‘New Appointment’ Button

1. The **New Appointment** button is in the top left hand corner of your screen on the **Home** tab.
2. Click the **New Appointment** button to open the Appointment dialogue box.
3. Type in the details of the appointment in the relevant spaces and Click **Save & Close**.
4. The appointment will then appear in your calendar. All-day appointments will appear in the blue band at the top of the day view.

Creating a New Appointment Directly From the Calendar

You can save a little time and avoid having to enter date and time details for the appointment by working directly from the calendar.

1. Find the point in your calendar where you would like to make the appointment and point the mouse at it.
2. Click on the time slot (or click and drag to select a larger time slot) and type in the title of the appointment. This may be all you need to do.
3. If you need to add further information about the appointment, double click on it to open the appointment dialogue box as above.
Changing or Deleting Existing Appointments

Outlook makes it easy to adjust an appointment. As with creating one, you can either amend it from the appointment dialogue box, or adjust it directly in the calendar.

Amending or Deleting Appointments from the Dialogue Box

1. Find the appointment that needs to be adjusted in your calendar.
2. Double click on the appointment to open the **Appointment Dialogue Box**.
3. Make changes in the appropriate sections of the dialogue box.
4. To delete the appointment, click on the **Delete** button.
5. Click **Save & Close**

Amending or Deleting Appointments Directly from the Calendar

Often the only thing that needs to be changed about an appointment is the time at which it takes place. In these cases it can be easier to amend it directly from the calendar.

1. Locate the appointment in your calendar and click on it.
2. You can delete the appointment if you wish by either pressing the **delete** key or clicking on the **Delete** button.
3. To amend the appointment time, use the resizing handles to adjust the start time (top edge) and/or the finish time (bottom edge) of the appointment.
4. Click and drag from the **middle** of the blue appointment area to move it.
5. If you need to move the appointment to a very different time (further than you can conveniently drag), then you can use the cut and paste keyboard shortcuts. Select the appointment, press Ctrl-X to cut, select the new time and press Ctrl-V to paste to the new location.

**Keeping Appointments Private**

We have already seen that it is possible to allow other people to view your calendar appointments. However, you wish to keep details of some appointments private. In these cases, other people will be able to see that an appointment is made and that you are busy at that time, but they will not be able to see what the appointment is about.

1. Locate the appointment you wish to make private and double click to open the Appointment Dialogue Box.

2. Mark the appointment as private by clicking on the ‘padlock’ icon.

3. Although you will continue to see all details of the appointment, other users will see the time blocked out with a padlock symbol indicating that it is private; the subject and all details will remain private.
**Setting Appointments as Recurring**

Some appointments happen at the same time every day (or every week/month etc). Rather than entering these individually, one appointment can be created and then set as **recurring**. This will make it appear identically on a regular basis. You can determine the frequency of the recurrence. The set of recurring appointments is linked together so can be dealt with as a group, but can also be manipulated individually if required.

1. Create a new appointment or open an existing one through the Appointment Dialogue Box.
2. Click the **Recurrence** button.

3. Review the options in the **Appointment Recurrence** dialogue box.
4. Adjust **Start/End** times and **Duration** as required.
5. Set the **Recurrence Pattern** to have the appointment repeat at the appropriate intervals
6. Set the **Range of recurrence** to limit the start and end dates of the series or the number of recurrences, or have open-ended recurrence by selecting **No end date**.
7. Click **OK**.
8. Click **Save & close** in the **Appointment** dialogue box.
Your series of appointments will now appear on your calendar marked to indicate they are recurring.

Note that the Wednesday appointment below is at a different time to the rest of the week. This is because this occurrence has been amended.

Changing Recurring Appointments

It may happen that individual occurrences in a series of recurring appointments will need to be changed, or even deleted.

This is possible to do as long as you let Outlook know whether you are considering the whole series or just the individual appointment.

1. Double click on a recurring appointment to open it.
2. This will open the Open Recurring Item dialogue box where you should select whether you are considering amending one occurrence or an entire series. Select the appropriate option and continue.
3. After making this selection the Appointment Dialogue box will open as normal and you will be able to make amendments. The amendments will be applied as you have dictated in this dialogue box.

A similar message will appear if you attempt to delete a recurring appointment.
Creating Appointments for Others

If you have access to somebody else’s calendar, in other words if they have shared their calendar with you and given you the right level of permission, you can create appointments for someone else.

1. Open the colleague’s calendar by checking the box by their name in the navigation pane.
2. Click in your colleague’s calendar to select it.
3. Create the appointment in the normal way – either by typing into the desired time-slot on the calendar or by clicking on New Appointment or New Meeting as described earlier.

4. Your colleague will be able to view the appointment in their own calendar.
4. Meetings (for you and others)

In Outlook, Meetings are appointments that involve other people. You can create meetings in stand-alone versions of Outlook as well as in networked versions using Exchange Server. They can be used to manage the scheduling of meetings and who is or isn’t invited to attend.

Creating a Meeting

Creating a meeting is initially the same process as for creating an appointment. In creating an appointment you will notice that in both the main Outlook ribbon and in the Appointment Dialogue Box ribbon there is an Appointment tab.

1. Click on the Invite Attendees button

This will open a Meeting tab where you can select who you would like to invite to the meeting

2. Enter the email address(es) of the attendees for the meeting. Attendees do not have to have email addresses on the same network as you – they can be non-users of Outlook even. Separate multiple addresses with semi colons (;).

3. Amend time/date details of the meeting if required.

4. Enter the text of any message in the message section as well. The recipient will see it in the same way as an ordinary email message and click Send to send the invitation message.

The meeting will appear in your calendar in the same way as an appointment. It will also provisionally appear in the calendars of all recipients who use Outlook.
Using Scheduling Assistant to Determine the Best Meeting Time

When you send a meeting invitation to an Outlook user, it will appear in their calendar as a provisional event. The recipient of the invitation will have the option of accepting or rejecting it. If the recipient is already busy at the time, then you are likely to get a rejection and may need to reschedule the meeting.

Scheduling Assistant makes it possible to avoid this before sending the invitation by helping you to work out the best time for the meeting and to manage your attendees. Where colleagues’ calendars have been shared with you, it will display their free/busy time slots and allow you to choose the best time.

1. Before sending the invitation, click on **Scheduling** to view the Scheduling Assistant.
2. Adjust the start and end times of the meeting to fit in with the free times of the attendees.
3. Use **AutoPick** to automatically select the best time if you have a lot of attendees. This selects the next available time with the highest number of available attendees. Click to step through **AutoPick** options.

NOTE: All invited attendees are displayed in a list on the left hand side. Where the attendee’s Outlook account is within the organisation, their busy periods are highlighted in blue. Where the attendee’s account is outside the organisation, the calendar is shown ‘greyed out’. When this happens for someone within your organisation, it means that your contact record for this person has become corrupted. To fix this, delete the record in your personal contacts list and recreate it from the LSE global list.
**Adding Attachments to Meeting Invitations**

A meeting invitation is a kind of email message. You can include an attachment just like in an ordinary email.

You can add an attachment when you create a meeting, or later. If you add later, you will need to resend the invitation to make sure the attachment reaches the attendees.

1. From the Meeting dialogue box, click **Attach File** in the **Insert** tab.
2. Browse for and attach a file in the normal way.
3. Click **Send** or **Send Update** to send the invitation and attachment.

**Booking Resources**

If you are using Outlook with Exchange Server, then you can not only invite attendees to a meeting, you can also book resources like rooms, projectors and the like.

Before you can use this, the resources themselves need to have accounts set up in the same way that your own Outlook accounts were set up. They also need to be configured to respond automatically to meeting requests etc. This is a job for your IT Support Team.

Once this is done, you can book resources in the following way:

1. To begin with, create the meeting in the usual way.
2. Click on **Scheduling** to view the scheduling assistant.
3. Start typing the name of the resource you wish to schedule in the box labelled **click here to add a name**.
4. If you can’t remember the exact name of the resource, click on the **Check Names** button.

This will bring up the **Check Names** window:

5. Scroll through the list of available resources to find the resource you need. Select it and click OK.

6. Once the identity of the resource is established, it will appear in the scheduling assistant together with indicators of when it is free or busy. Save and send the meeting invitation in the normal way.

Note that you can use the **Check Names** feature to find **people** you wish to invite to meetings as well as resources.

**Responding To Meeting Invitations**

As well as sending your own meeting invitations, you are bound to receive invitations to meetings as well. You will probably first notice the invitation in your inbox looking very much like an email.
1. Double click on the invitation to open it.

A fragment of your own calendar is displayed in the invitation showing the time immediately around the proposed meeting.

Note that initially the meeting is scheduled in your calendar ‘provisionally’ – indicated by the ‘greyed’ appearance and hatched lines. On accepting, it will appear in your calendar in the normal way.

2. Consider whether you want to accept the invitation or not. In this case the invitation conflicts with a pre-existing appointment of your own.

3. There are a number of possible response options available in the Meeting tab at the top:

a. **Accept** – the meeting will be confirmed in your calendar and you will be able to send a response confirming your attendance to the meeting organiser.

b. **Tentative** – it will stay in your calendar as a provisional appointment and this response can be sent to the meeting organiser.

c. **Decline** – the meeting will be removed from your calendar and a decline response sent to the meeting organiser.

d. **Propose New Time** – you can access your calendar and can send a response suggesting a new time to the meeting organiser.
4. In each option you will be prompted as to whether or not you wish to send a response to the meeting organiser. Generally it is best to do this in order that the meeting organiser is able to properly **track** the responses received to the meeting request.

**Tracking Meeting Request Responses**

Outlook allows meeting organisers to record and check the responses received from attendees that have been invited to a meeting.

Where the attendees have Outlook and have elected to send a response the recording of the responses is done automatically.

Where the invited attendees do not have Outlook, the meeting request will appear to them as just another email and they will be unable to send an automated response. However, Outlook does allow meeting organisers to manually update the status of an invitation.

1. Open the meeting.

2. In the **Meeting** tab, click on **Tracking**. This will open a list of all the invited attendees (including the meeting organiser) and the status of their responses.

3. To manually amend response status, click on the **response** cell for the attendee in question and you will see a drop down list of potential responses. Otherwise the cells will update automatically as responses are received.
Changing Meeting Invitations

Details of a meeting may need to be changed. This could include re-scheduling the meeting to a different time or adding or removing attendees.

Adding and Removing Attendees

1. In both of these cases you will need to open the meeting.

2. Click Scheduling to access the Scheduling Assistant and either add an email address to the Click here to add a name cell or select names from your address book by clicking on the Add Others button.

3. To remove an attendee from a meeting, simply uncheck the tick next to the attendee’s name. The attendee’s name will remain on the scheduling assistant list, but will be shown as not required.

4. Click Send and you will be prompted about the people you would like to send the updates to.
Cancelling a Meeting

Cancelling a meeting altogether can be done either from the Meeting dialogue box or from the main calendar window.

1. There is a **Cancel Meeting** button located near the left hand end of the **Meeting** tab of the ribbon on either window. Click on this and the Meeting dialogue box will open.

2. Send the cancellation by clicking the **Send Cancellation** button.
5. Combining Email, Calendar and Tasks plus Other Email Tips

Outlook has features other than the Calendar. It can also handle Emails and Tasks in a sophisticated way. It is possible to use all these features in combination to create appointments or tasks from emails and to use some email features to set criteria on your meeting invitations before you send them. This can be useful if, for example you wish to have a cut off time for receiving meeting invitation responses or if you wish to have replies sent to a different email address than your own. Further, you can also change the way your meeting invitations display in your mailboxes so that you can keep track of the conversations you have been having with the meeting invitees.

Converting Emails to Appointments Including Attachments

It is possible to turn emails directly into calendar appointments. In the example below an email has arrived describing a meeting that will be taking place. Convert this message into an appointment by following these steps:

1. Select the email in its email folder – in this case the Inbox.
2. Right-Click and Drag the email until the Calendar button on the left hand side of your screen is highlighted. Then let go of the mouse button.
3. A menu will appear offering a range of ways in which your email message can be placed in the calendar. Note that there are options to Move, where the email will be moved automatically into your Deleted folder, or Copy where the email will remain in your email list as well as in your calendar. Select the option that suits you best.
4. This will open an Appointment Dialogue Box. NOTE: the Appointment Dialogue Box may not appear to have opened. It will probably be ‘hiding’ behind the main outlook screen. Rest your mouse pointer on the Outlook icon in the Windows Task Bar at the bottom of the screen and click on the appointment dialogue box preview to open it.

5. The Subject line from the email becomes the subject of the appointment.

6. Specify the Location of the appointment manually if required.

7. Specify the Start time and End time of the appointment or mark it as an All-day event.

8. If you have copied the message, it appears as an icon in the main part of the appointment.

9. Double click on the Email message to open it, view the message and access any attachments.
If you accidentally drag the message to the appointment by **Left Clicking** the mouse, you will not see the menu of options described earlier. The meeting window will still open and display the message but the text of the email will appear in the main body of the appointment. Note that attachments are listed here but the attachment themselves are not present. Although a reference to the file copies across into the appointment, the file itself does not. You will need to do this manually.
To manually copy attachments from an email message to an Appointment:

1. Arrange your screen so that you can see both the email inbox and the Appointment Dialogue box.
2. Drag the attachment file from the email to the appointment.
3. Click **Save & Close** to store the new appointment and attachment.
Creating Tasks from Email Messages

Tasks in Outlook can also be used to help manage your workload. If you have a job that needs doing at a specific time you should create an appointment in your calendar. If the job could be done at any time, then listing it as a Task is more appropriate.

1. Right Click and drag the message to the Tasks button and let go.
2. A menu of options will appear. Select the appropriate option.

Could you get in touch with the designer this week and see if he has any suggestions for our next brochure.
Setting an expiry date for a meeting invitation

Use the Meeting Properties dialogue box to set parameters for a meeting invitation before sending.

1. Create the meeting as normal.

2. Click on the File tab in the meeting window. Select Info and click on the Properties button.

The Properties dialog box appears.

3. Set where you want replies sent, delivery time limits and expiry dates in the Delivery options section.
Using ‘Conversations’ To Change the Display of Messages

It can be useful to have email messages relating the same subject grouped and displayed together in your email boxes. This includes displaying email messages held in various folders.

1. Switch to the Mail screen and then to the View tab.
2. Check the Show as Conversations tick-box
3. Change the Conversation Settings option to Show Messages from Other Folders to include meeting invitations in the display

Items relating to the same conversation will be displayed together.
6. Helpful Internet Links

There are many internet sources which are helpful in understanding your Outlook calendars. The following are just a few. A search on Google will uncover advice on virtually any issue you might be having. No guarantee is offered for the information given on external sites.

General Outlook Help

http://www2.lse.ac.uk/intranet/LSEServices/itservices.guides/home.aspx

Help with Synchronisation

LSE’s own Help pages

http://www2.lse.ac.uk/intranet/LSEServices/itservices/guides/usingYourOwnComputer/home.aspx

Android to Exchange:


iCal to Exchange:


iPhone/iPad to Exchange:

http://support.apple.com/kb/HT2480

Entourage to Exchange

http://www.youtube.com/watch?v=qhdCxiA8ml4